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All rights reserved. DMT licenses PADS software only upon the condition that you accept all of the 

terms contained in this license agreement. Each PADS license you purchase allows you to acquire 

data on one computer only. Data can be viewed in playback mode on an unlimited number of 

computers. 

This software is provided by DMT “as is” and any express or implied warranties, including, but not 

limited to, the implied warranties of merchantability and fitness for a particular purpose are 

disclaimed. Under no circumstances and under no legal theory, whether in tort, contract, or 

otherwise, shall DMT or its developers be liable for any direct, indirect, incidental, special, 

exemplary, or consequential damages (including damages for work stoppage; computer failure or 

malfunction; loss of goodwill; loss of use, data or profits; or for any and all other damages and 

losses).   

Some states do not allow the limitation or exclusion of implied warranties and you may be entitled to 

additional rights in those states. 

 

Trademark Information 

All Droplet Measurement Technologies, Inc. product names and the Droplet Measurement 

Technologies, Inc. logo are trademarks of Droplet Measurement Technologies, Inc. 

All other brands and product names are trademarks of their respective owners. 

 

Risks of Installing Additional Software 

Instrument computers from DMT are configured to acquire data in a reliable, robust manner.  

Typically, such instruments are either not connected to a network or are connected to a small, local 

network that is isolated from the internet, reducing the risk of viruses. Since anti-virus programs can 

cause erratic behavior when run in the background on data acquisition computers, DMT does not 

install anti-virus, anti-spam, or anti-malware programs. If you choose to install these programs, you 

accept the risk associated with them in terms of potential performance degradation of the software 

installed by DMT. 

 

For similar reasons, DMT recommends that you do not install or run other software on the dedicated 

instrument computer. Although the installation of some software may be unavoidable, it is particularly 

important not to run other software while the computer is acquiring data. 
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1.0 Introduction 

The Particle Analysis and Display System (PADS) is a software package that interfaces 

with instruments produced by Droplet Measurement Technologies (DMT) and other 

leading instruments used in the atmospheric sciences. This manual describes the PADS 

AIMMS20 module version 3.5.0.  

 

For an explanation of the basic PADS setup and instructions on how to acquire data using 

PADS, consult the PADS Overview Manual, DOC-0300. Definitions and calculations used in 

the AIMMS20 module are also described in the PADS Overview Manual.  

 
Note that PADS has an ADP module that displays a subset of the data displayed in the 

AIMMS20 module. The Air Data Probe (ADP) is a component of the AIMMS20 that can be 

purchased as a stand-alone instrument. Customers who purchase a stand-alone ADP with 

PADS receive the ADP module. Both the AIMMS20 and the ADP component are made by 

Aventech Research, Inc.  

2.0 Configuration 

Using PADS, you can configure both the software settings for the instrument and the 

instrument’s data display in PADS. The following two sections explain how to do this. 

Configuring the instrument’s software and display affects the default settings PADS uses 

when starting up. Some parameters can also be changed while PADS is running, but doing 

so affects the current session only.  

2.1 Configuring the AIMMS20 

Your AIMMS20 and data system should arrive preconfigured from DMT. In some cases, 

however, you may want to change the software configuration for the instrument. To do this, 

follow the steps below. Note: Droplet Measurement Technologies STRONGLY recommends 

that customers contact our office prior to changing any of the parameters in the instrument 

configuration. Improper changes can result in communication failure and/or changes in PADS 

computation algorithms, which can compromise data validity.  

 

1. Click on the ―AIMMS20‖ tab. 

2. From the Configure menu, select Configure Instrument. You will see the following 

window. 

http://www.aventech.com/
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3. Now you can configure the instrument parameters to your desired specifications. See 

the definitions below for explanations of individual parameters. If at any time you 

would like to revert to the previously saved values for the AIMMS20 parameters, press 

Cancel to exit the window without saving changes. Pressing Reset Parameters reverts 

parameters to their DMT-supplied default values. 

4. When you are done configuring the AIMMS20 parameters, press Save at the top of the 

Config editor window. Then press the green Reset Program button for the new 

configuration to take effect. Note that pressing the Reset Program button will clear 

any data currently being displayed.  

2.1.1 AIMMS20 Parameters 

Instrument #:  This lists the number corresponding to the instrument you are viewing, in this 

case the AIMMS20. If your AIMMS20 has been assigned instrument number one, you will see ―1‖ 

in this field. You should not need to modify the instrument number, and in fact you are unable 

to do so from within PADS.  

 

Sample Time:  This parameter indicates the time interval at which the AIMMS20 relays 

sample data. Note that you if you change this parameter, you will also need to change the 

 

Figure 1: AIMMS20 Configuration Editor Window 
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sample rate within the AIMMS20 setup utility, as described in Appendix B. Furthermore, you 

will need to change the Refresh Time on the Display Editor (see section 2.2) if you want the 

display to update at the new sample time.   

Note that if the AIMMS-20 is set to one Hertz, the instrument collects some data internally at 

a shorter interval than one Hertz. Wind speed and direction readings, for instance, are 

gathered at a rate of five Hertz and then averaged over the past four seconds. For channels 

that store instantaneous rather than averaged data, such as wind components, PADS displays 

the most recent data the AIMMS20 has relayed.  

 

At Startup Enabled / Disabled:  If you want the AIMMS20 to acquire data when PADS begins 

sampling, make sure this parameter is in the ―Enabled‖ mode. In some cases, such as if the 

AIMMS20 is inoperative, you may want to use this control to disable the probe. Disabling the 

AIMMS20 allows data to transmit from other instruments without interference. Data will still 

be written to the disabled instrument’s output file, but PADS will write ―NaN‖ to all fields.   

 

COM Port:  This is the serial communications port that the AIMMS20 uses to connect with the 

computer. This number should match the computer hardware configuration for the particular 

computer you are using. If you are not using multiple computers, this number should not be 

changed.  

 

Baud Rate:  The Baud rate for the probe is defined at manufacture, and PADS prevents you 

from changing it. The program lists this parameter because some probes can run at different 

baud rates. So if the hardware is reconfigured, the baud rate may change. In general, a higher 

baud rate means that the probe can transmit data more quickly to the computer. However, 

higher baud rates may not work with some computers and can result in unreliable data 

transmission.  

 

2.1.2 Channels Table 

The channels listed in the Channels table are configurable. These are data channels returned 

by the AIMMS20. The Channels table lists conversion equations PADS applies to these channels, 

if they exist.  

Note: While it is possible to use the Channels table to rename output channels, in most cases 

your system is preconfigured so that the channels in the table correctly match output from 

the AIMMS20. While minor rescaling of output channels can improve data accuracy, DMT does 

not recommend altering your basic channel configuration. 
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The right-hand fields in the channels table indicate the coefficients to be used in the 

conversion equation. Figure 2 shows the setup for a hypothetical channel with the second-

order polynomial conversion equation, as follows: 

 New_Channel = 34.01 + 0.061 x + 0.0092 x2 

where x is the value returned by the instrument. 

 

The number of coefficients that PADS uses depends on the equation type. ―None‖ does not 

use any coefficients. ―Linear‖ uses the first two coefficients, which are listed in the first two 

table cells after the equation type. ―4th Order Poly‖ uses one to five coefficients. 

(―Thermister D‖ and ―Thermister G‖ are complicated, pre-set equations used by some 

instruments, while the ―Custom‖ options are reserved for future use. You should not need to 

select these options.) 

In cases where there are non-zero numbers in cells that are not used in the function, PADS 

ignores these numbers. For instance, if you specify ―Linear‖ as your function and have .32 in 

the farthest right cell, the program will just ignore this value.  

Pressing Reset Parameters resets all configuration parameters to their default values. 

Pressing Reset Channels resets all the channels in the Channels table to their default values.  

After making changes in the instrument configuration window, you will need to press the Save 

button and then click the green Reset Program to activate these changes. Note that clicking 

Reset Program will clear any data PADS is currently displaying.  

 

2.2 Configuring the AIMMS20 Display 

To configure the AIMMS20 display, click on the AIMMS20 tab if you have not already done 

so. Then select Configure from the menu bar and click on Configure Display. This will 

bring up the following window.  

 

 

Figure 2: Example Channel Specifications in the Config Editor Window 
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You do not need to modify the Display # or Instrument #. Changing the Refresh Time 

allows you to set the time intervals for data display during acquisition mode; you can 

choose any time that is equal to or greater than the sample time. (Choosing a time less 

than the sample time is not useful, since the same data will be displayed multiple times.)  

 

The AIMMS20 Display Parameter box at the bottom of the window allows you to configure 

the channels on the AIMMS20’s selectable graphs. The first of these charts is located in 

the Selectable XY tab. This graph plots the channel specified as ―AIMMS20 X Channel‖ 

with respect to the channel specified as ―AIMMS20 Y Channel.‖ The two other selectable 

charts are displayed on the Selectable Plot and Heading tab, and they chart the 

―AIMMS20 Chart 1‖ and ―AIMMS20 Chart 2‖ channels with respect to time. For information 

on specific channels and their definitions, consult Appendix A: AIMMS20 Channels and the 

PADS Overview Manual’s Appendix A: Definitions. 

 

 

Figure 3: AIMMS20 Display Editor Window 
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To change the channels in the Display Parameter box, you can click on the arrow buttons 

to scroll between available options. You can also click on the white fields to bring up a 

list of all the available channels, from which you can choose the one you want. 

 

Clicking on Reset Parameters restores the display parameters to their original default 

values. 

 

When you are done, click on Save to update the configurations or Cancel to revert to the 

previous configurations. After you reset PADS, you will be able to see any changes by 

clicking on the AIMMS20 Selectable Charts tab. Note that clicking Reset Program will 

clear out any data currently being displayed.  

 

Configuring channels in the Configuration Display Editor will change the display upon 

start-up. Once PADS has started, you can select any channels to be displayed. See the 

―Selectable Charts‖ heading under the ―Chart Displays‖ section for more information.  

  

3.0 The AIMMS20 Window 

The different parts of the AIMMS20 Window are discussed below.  

 

The Status indicator turns bright green when the status indicator is on, as shown in 

Figure 4. Status is on when all of the following conditions are met: 

 

1.) PADS has received data from the AIMMS20. 

2.) No communications error has been reported. 

3.) The AIMMS20 has reported a valid wind solution. 

 

A valid wind solution (Wind Solution=1) in turn depends on several conditions:1  

 

1.) The attitude solution is running. The attitude solution provides roll, pitch, heading 

and inertial velocity components of the aircraft. To generate this data, the 

AIMMS20 requires valid navigation solutions from both GPS processors and a 

minimum of four matched satellite pairs.  

2.) The pitot-static pressure reported from the air-data probe is above a threshold of 

200 Pa / 2 mBar (for fixed-wing aircraft), and 50 Pa / .5 mBar (for helicopter 

setups). 

3.) The purge-valve sequence is not in effect. (This condition is applicable to canister 

models that have this option installed.) 

                                            

 

 
1
 Information obtained from Aventech Research Inc., which manufactures the AIMMS20.  
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When the Status indicator is off, data being displayed in the 3-D Tracking Plot may not be 

current. For more details, see section 3.4. 

 

For explanations of the Enable button, COM Port indicator, and Fault/No Fault button, 

see the ―Instrument Tabs‖ section of the PADS Overview Manual. 

 

The AIMMS20 tab has three sub-tabs, which are described below. 

3.1 Data Tab 

Figure 4 shows the Data tab. 

 

 

 

 

Figure 4: AIMMS20 Data Tab 
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The Data tab displays commonly used channels. For information on specific channels, 

their definitions, and their acceptable ranges, consult Appendix A: AIMMS20 Channels 

and the PADS Overview Manual’s Appendix A: Definitions. 

 

3.2 Selectable XY Tab 

The Selectable XY tab plots any available channel with respect to any other available 

channel. Use the fields marked AIMMS20 Y Channel and AIMMS20 X Channel to specify 

channels for the graph. You can either click on the text control to the right, which brings 

up a selectable list of channels, or you can use the button on the left to scroll between 

channels. Changing the channels from this tab changes them for the current session only; 

to change the values used upon program start-up, go to Configure > Configure Display 

and select the desired channels.  

 

Data values for the both the X and Y channels for the current moment in time are listed 

in the gray boxes to the right of the channel controls (Figure 5).  

 

 
 

Click on the Plot Properties  button to access various options for modifying the 

graph.  

 

On both the x and y axes, you can change the scale by typing a different number into the 

starting and ending values on each axis. In acquisition mode, you must disable autoscaling 

(see below) before you modify fields in this way.  

 

Right-clicking on the chart brings up a drop-down menu with various options, e.g.: 

 

Autoscale  This autoscales the relevant axis. In autoscaling mode, the minimum 

and maximum values of the axis are set automatically so that all data points can 

be seen in the display. Note that on charts that have autoscale buttons, like the 

large histogram chart on some instrument tabs, the buttons override the Autoscale 

options in the drop-down menu. To see autoscaling options in the drop-down 

menu, position the cursor over the relevant axis before right-clicking. Note that 

you may not always be able to autoscale the x-axis.  

 

Copy Data  This copies the chart to the clipboard using a screen capture. This 

chart can then be pasted into other documents like Word or PowerPoint 

presentations. 

 

Figure 5: Selectable XY Tab–Viewing X Channel Value for Current Time 
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Export Simplified Image  This copies a simplified image of the data to the 

clipboard or an output file. You can choose the format you desire—bitmap (.bmp), 

encapsulated postscript (.eps), or enhanced metafile (.emf). Note that when you 

select the .eps option, you must copy the data to a file. Unless you specify 

otherwise, output files will be saved in the time-and-date-specific output file 

directory for the current session. 

   

Clear Graph  This erases the currently displayed data points from the graph. 

 

3.3 Selectable Plot and Heading Tab 

The Selectable Plot and Heading tab is shown below.  

 

 
 

The top section of the tab displays two overlaid time-series graphs. PADS displays the 

channels listed in the graph’s left-hand fields in green. The y-axis legends for these 

 

Figure 6: AIMMS20 Selectable Plot and Heading Tab 
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channels are listed on the far left side of the graphs. It displays right-hand fields in blue, 

and it lists these legends on the far right of the graphs.  

 

To change the channels plotted in the charts, you have two options: 

 

1.) To change the charts for the current session only, use the controls in the upper 

corners of the charts to select the channel you desire. You can either click on the 

text control to the right, which brings up a selectable list of channels, or you can 

use the button on the left to scroll between channels.  

2.) To change the channels shown in the chart’s display when PADS starts, go to the 

Configure menu, select Configure Display, and choose the desired channels. Then 

press the Reset Changes button to apply this configuration.   

When you view charts in playback mode, the currently selected moment in time is 

indicated by a red cursor. The y-axis value for this time is indicated by cross (+) on this 

cursor. Y-axis values marked with the cursor are always for channels displayed in green. 

Note that when you display a large range of time-series data, the chart display does not 

have sufficient resolution to display each individual time point. To increase resolution, 

zoom in on the data by changing the time interval to a smaller range. 

 

For information on changing the graph scale and on options for copying, exporting and 

clearing data, see section 3.2. 

 

The bottom section of the Selectable Plot and Heading tab displays two dials. The first 

shows the wind direction, which is the direction the wind is flowing from (not the 

direction the wind is flowing to). The second shows the direction in which the aircraft is 

heading. The angle displayed is the angle from true north.  

 

3.4 3-D Tracking Plot 

The 3-D tracking plot provides a three-dimensional view of the aircraft’s latitude, 

longitude, and altitude. Figure 7 shows the 3-D tracking plot.  
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A red dot indicates the aircraft’s location. You can rotate the tracking plot in three-

dimensional space by clicking on the plot, holding down the mouse, and moving the 

mouse around. Using the scroll button on your mouse will let you zoom in and out on the 

plot. If you hold down the shift key and the left mouse button, you can change the plot’s 

position in the window. 

 

The ViewMode indicator allows you to modify the tracking plot’s display. The default 

mode is User Defined, which displays the view in three dimensions. ViewMode’s other 

options project the 3D data onto two axes—longitude by latitude, altitude by latitude, or 

altitude by longitude. Selecting one of these options has the effect of temporarily 

―collapsing‖ the omitted axis as if you were looking at cubical space head-on. For 

instance, displaying the same data as shown in Figure 7 in ―Alt x Lat‖ mode collapses the 

y-axis, longitude, as shown in Figure 8. 

 

Figure 7: AIMMS20 3-D Tracking Plot 
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When you rotate the display, however, the view returns to three dimensions. 

 

Occasionally a problem with the AIMMS20 data feed results in erroneous and extremely 

high or low readings for altitude, latitude or longitude. This problem usually only lasts for 

one sampling instance, but it can corrupt the 3-D tracking plot by altering the plot’s scale 

and the aircraft’s position. In order to circumvent this problem, PADS tests the current 

data. If it detects an erroneous reading, it turns the Status indicator off and displays the 

previous sampling instance’s data. PADS only reuses data this way for ten samples, 

however; if the program detects more than 10 erroneous readings in a row, it inserts 

―NaN‖ (not a number) for all the AIMMS20 data channels. The 3-D plot omits NaN data 

from its display, so in this case the track will appear to have gaps. The erroneous data 

will not cause the plot axes to rescale inappropriately, however. During the time that 

older data are being recycled, PADS sets the Status output channel to [-1] * [the number 

of samples old data have been reused]. E.g., a Status value of -5 indicates old data have 

been recycled for the previous five samples. Once PADS starts writing ―NaN‖ to the 

output channels, Status stays at -10.  

 

The Scale Controls for the 3-D Tracking Plot (Figure 9) appear in the bottom right of the 

window.  

 

 

Figure 8: 3-D Tracking Plot in “Latitude by Altitude” Mode 
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To enable autoscaling, click on the autoscale button if it is not currently on. It will 

illuminate (see the Latitude autoscale button in Figure 9), and the controls above the 

autoscale button will be disabled.  

 

If autoscaling is not enabled, two controls appear above the autsoscale button. These 

allow you to enter the minimum and maximum values for the scale—latitude and 

longitude in degrees, and altitude in meters. 

 

 

 

 

 

  

 

Figure 9: Autoscaling Latitude 
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Appendix A:  AIMMS20 Channels  

 

A complete list of AIMMS20 data channels appears below. The AIMMS20 output file will 

contain data values for each channel for each sampling instance. You can also plot each 

of these channels against time using the AIMMS20 Selectable Charts tab.  

 

For definitions of the channels, see Appendix A in the PADS Overview Manual.  

 

The AIMMS20 relays two data packets of information for each sampling instance. The 

channels in bold below are sent in the first data packet, which mostly contains 

information on wind conditions. Channels in italics are ones that the AIMMS20 sends in 

the second packet. 

 

End Seconds Seconds (packet 2) 

Day of Year Latitude (deg) 

Year Longitude (deg) 

Status Altitude (m) 

Hours (packet 1) Velocity N (m/s) 

Minutes (packet 1) Velocity E (m/s) 

Seconds (packet 1) Velocity D (m/s) 

Temperature (C) Roll 

RH (%) Pitch 

Pressure (mBar) Yaw 

Wind Flow N TAS (m/s) 

Wind Flow E Vertical Wind (m/s) 

Wind Speed (m/s) Sideslip Angle 

Wind Direction (deg) AOA pres diff 

Wind Solution Sideslip Diff 

Hours (packet 2) Spare 1-8 

Minutes (packet 2) GPS Time / UTC Time 
 

 

AIMMS20 channels fall into several broad categories: 

 

- Time channels 

- Wind and ambient data conditions channels (e.g., Temperature and RH%) 

- Aircraft data channels (e.g., Latitude, Longitude, Velocity, Pitch) 

- Unused channels (Spare 1 – 8) 

- Other (Status) 
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Appendix B:  Changing the Sample Rate in the 

AIMMS-20 Configuration Manager 

 

By default, the AIMMS20 is configured to sample at a rate of 1 sec / 1 Hz. You can select 

other sample rates from within the PADS Configuration Editor; see the Sample Time 

entry in section 2.1.1. However, if you do this, you will also need to reconfigure the 

AIMMS20 to match this sample rate. To do this, follow the steps below. 

 

1.) Make sure the AIMMS20 is turned on. 

 

2.) Connect the computer’s AIMMS20 cable to the black configuration connector 

(Figure 10).  

 

 
3.) Select Start > All Programs > aimcfg150. This will bring up the AIMMS20 

Setup Utility.  

 

4.) Click on Setup, which will bring up the window in Figure 11. 

 

 

 

Figure 10: AIMMS20 Data Cable Connection during Configuration  
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5.) Change the Broadcast period to the desired sample time in seconds. For instance, 

Figure 11 shows the broadcast period set to .5 sec / 2 Hz. 

 

6.) Click OK. 

 

7.) Close the AIMMS20 Setup Utility (click on File > Exit). 

 

8.) Switch the data cables back to their original configuration, so the white AIMMS20 

cable is connected to the computer’s AIMMS Data Out cable.  

 

 

Figure 11: AIMMS20 Setup Window 
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9.) Proceed with data collection. 

 

 

Appendix C:  Revisions to Manual 

 

Rev. Date Rev No. Summary Section 

2-4-11 B 
Added instructions on configuring sample time in 
AIMMS20 Setup Utility. 

Appendix B 

4-7-11 B-1 Updated List of Figures and Figure 9 
Frontmatter, 
3.4 

 

 

This document replaces DOC-0185, the AIMMS20 PADS Operator Manual for PADS version 

2.X.  

 

Figure 12: AIMMS20 Data Cable Connection during Data Acquisition 


